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1   GETTING STARTED 
 
1.1 Introduction 
 

Welcome to Gazelle Label Writer, the latest label design and printing software from GENERAL 
CODE, which provides a user-friendly front end to the ALFA 1050-2050-1100-2100 Direct 
Thermal/Thermal Transfer printers.  The software provides all of the features necessary to design 
and print custom label formats quickly and easily in a variety of sizes and styles. It has now been 
extensively updated to provide a host of additional features which make it more powerful, but 
easier to use.  

 
1.2 Main Features 
 

GLWW is a DOS based programme that enables complex labels to be designed with full What-
You-See-Is-What-You-Get (WYSIWYG) on screen capabilities.  The software has features to 
enable a variety of text, barcode formats and graphics to be reproduced easily and quickly.  It 
provides fixed and variable fields for text and barcodes, auto-increment fields, dBase III/IV and 
text database access, PCX format images and automatic date and time stamping at print time. 

 
 The software uses Bitstream Speedo fonts matching those contained in ALFA printers for 

maximum typographical flexibility. Handling of PCX format images has been improved in 
GLWW V2.4 allowing scaling and rotation of black and white and true 256-greyscale images. 
Print queuing of multiple printers simultaneously reduces waiting time combined with a flexible 
and informative status report.  

 
A demonstration version of the software is available which has all the features of the full package 
but with the following restrictions: The software will only enable you to save and print a file called 
DEMO.LBL, and when the label is printed an additional line of text "Demonstration Version" is 
printed at the top of the label. 
 

1.3 Package Contents 
 
 The software is supplied in its own case folder which includes the following items :- 
    GLWW Diskette 
    Users Manual 
    Security Dongle 
    Registration Card 
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1.4 Requirements 
 

In order to run the software you will need a computer which has the following minimum hardware 
:- 

 
    640K of RAM (Minimum 520K free) 
    Hard disk (Minimum 1.6 MBytes free) 
    VGA card and monitor 
    Microsoft compatible Mouse 
    A parallel or serial port for the printer 
 
 You are strongly recommended to be running DOS 5.0 or later and have 384K of expanded 

memory available. Smartdrive or any other disk cache can also increase performance. 
 
 GLWW is designed to work with all the latest ALFA  printers having firmware revision 1.20 or 

later. Many older printers can also be supported or updated. Contact your supplier for further 
details. 

 
1.5 Installation 
 

The software is contained on a single diskette which includes installation routines for Windows 
and DOS. Use whichever is most convenient to you. If you encounter problems with the 
installation, refer to Appendix C for further details. 
 

 To perform a Windows Setup: 
 
 1. Place the diskette in your floppy disk drive (usually either A: or B:) 
 
 2. Start Windows. Select Run from the File menu and enter: 
   X:\SETUP.EXE 
  replacing X with the floppy disk drive name. 
 

3. During setup, the GLWW Configuration Utility will be run. Enter the appropriate details 
and select Exit from the Configure  menu. (For details on using the Configuration Utility, 
see Section 6.) 

 
4. To start GLWW, double click on the GLWW icon in the Program Manager. 
 
 

 To perform a DOS Installation: 
 
 1. Place the diskette in your floppy disk drive (usually either A: or B:) 
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 2. Change to the floppy disk chosen (normally type A: or B:) and run Install using the 
format: 

            INSTALL <drive:\directory> 
    where  -  drive: is the drive name where the files    
   are to be copied to (e.g.  C: or D:) 
               - directory is the name of the directory    
   into which the files will be copied (This      
 is often \GLWW) 
    Example INSTALL C:\GLWW 
 

3. During installation, the GLWW Configuration Utility will be run. Enter the appropriate 
details and select Exit from the Configure  menu. (For details on using the Configuration 
Utility, see Section 6. 

 
4. For optimum performance, GLWW requires 384K of expanded memory. If you do not 

already have EMM386 installed, add the following line to your CONFIG.SYS file :- 
  DEVICE = <DosPath>EMM386.EXE AUTO 
 Where <DosPath> is the directory containing the EMM386 program. 
 
5. To start GLWW, change to its directory and type GLWW. 
 

1.6 Product Registration 
 

Please complete the registration card enclosed with the software package as soon as you have 
completed the installation.  Completing the registration card will entitle you to receive Technical 
Support, and also to be included on our mailing list, which will ensure that you receive priority 
details on any new products and upgrades that are introduced. 
 
Extended Support for the software is available for an annual subscription, which will entitle you to 
free product upgrades.  For further information on extended support please tick the box on the 
registration card. 
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2 LABEL DESIGN OVERVIEW 
 
2.1 The Label Screen 
 
 The label screen shows a graphical representation of the label on the screen exactly as it will 

appear when printed.  The various fields in the label format may be re-positioned with the mouse 
and the data changed by selecting the field. When placing new fields, the data type is selected by 
means of the icons at the bottom of the screen, which represent the various field types. 

 
2.2 Mouse Functions  
 

The following terms are used to describe the actions of the mouse referred to in this manual :- 
 

 CLICK ON means to position the cursor over the desired item and to press and release the left 
mouse button. 
 
DRAG means to position the cursor over the desired item and depress the mouse button, and 
while continuing to hold the button down, move the mouse to reposition the object on the screen.  
As you drag, you will see an outline of the item you are re-positioning. 
 
LEFT MOUSE BUTTON is used to select a particular field for editing or re-positioning. Field 
icons are also selected using the left button 
 
RIGHT MOUSE BUTTON is used to edit the contents of a particular field. When a field has 
been selected, click on the field to bring up the field editor screens. 
 

2.3 Function Keys 
 
 The following function key can be used to achieve keyboard shortcuts for some of the functions, 

details of the particular function keys available are shown in each menu and at the bottom of the 
label editor menu screen  :- 

  
FUNCTION KEY OPERATION 

F1 On-Line Help 
F2 Create New Label 
F3 Load Label 
F4 Save Label 
F5 Print Label Format 
F7 DOS Shell 
F8 Edit Label Field 
F9 Label Editor Menu/Layout Toggle 
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2.4 Data Entry Conventions 
 
 To enter data or values into any of the dialog boxes you have to select the individual parameter 

box that you wish to enter or edit data using the left mouse button.  Information may then be 
typed into the box using the keyboard.  When all of the information for a particular dialog has 
been entered select the appropriate action required by clicking on the box at the bottom of the 
dialog.  Boxes which can be edited will normally be displayed in reverse text, and boxes which 
"open" into another dialog are shown by means of the box details being surrounded by < > 
characters. 

 
2.5 Help Messages 
 
 Comprehensive context sensitive help is available at all times in the program.  The help messages 

are displayed by either pressing F1 or by clicking the left mouse button on the help menu or icon. 
 
 To move through a topic, use the arrows on the scroll bar or the cursor keys. A master index of 

available topics is available from the Help menu in the Label Editor or Print programs. 
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3 RUNNING THE SOFTWARE 
 
3.1 Running GLWW 
 

To run GLWW from DOS you must follow the steps below :- 
 
1. Change to the GLWW directory (Type CD\GLWW) 
 
2. Run the main programme (Type GLWW) 
 
To run GLWW from Windows, double click on the GLWW icon in the Program Manager. 
 
The programme will load and take you into the main menu selection screen. 
 

3.2 The Main Menu 
 
The software is based around a main menu which allows access to all of the functions of the 
software.  Each function is selected by clicking with the mouse pointer.  The options that are 
available from the main menu are shown in Fig 1 below :- 
 

 
 

 Fig 1   Gazelle Label Writer Main Menu 
 
 The function of each of the menu selections is detailed in the following sections. 
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4 LABEL EDITOR MENU 
 

The Label Editor menu is displayed across the top of the screen as a row of pull-down menus.  
To select a menu either click on the particular function with the mouse or press the ALT key 
followed either by the highlighted letter from the function name, or by using the left/right arrow 
keys.  To the right of the menu bar, the current units, label format name (an asterisk next to the 
name, indicates the file has not been saved) and the size of the current label format are displayed.  

 
4.1 File Menu 
 

The File Menu commands are used to manipulate files with such operations as opening, saving, 
renaming and  printing files.  

 

 
Fig 2    File Menu 

 
 The menu is selected by clicking on the File button on the menu bar (Alt-F) which then displays 

the pull-down menu above. Options may be selected using the mouse, hot key letter or the 
cursor navigation buttons.   

  
4.1.1 Create New Label 
 
 Click on the file menu heading with the mouse and select the Create New Label function, which 

will bring up the Create New Label dialog box. The shortcut key for this command is F2. 
 

 
Fig 3 Create New Label Dialog  
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 The dialog box allows you to enter the name for the new label format, which should follow 
normal DOS conventions of 8 characters. The label name can contain spaces but it is not 
recommended. An LBL extension will automatically be added to the new label filename.  The 
dimensions of the printed area of the label should be entered and the position of this area within 
the physical label should also be specified. The label must be no wider or longer than the 
currently configured printer will allow. 

 
 Double Image Printing can also be enabled and the offset from one image to the next specified.  

Double Image Printing prints the same print area twice on the label, one image above the other, 
useful for example if printing box end labels. The offset between the first and second images 
should also be specified. 

 
4.1.2 Load Label 
 
 This command lets you load an existing label formats.  Activating this option brings up the Load 

Label dialog box.  The shortcut key for this command is F3. 
 

 
Fig 4 Load Label Dialog 

 
The dialog box for the load label produces a list of all of the label format in the default directory.  
The required file can either be selected from the list of files, or by typing the file name into the 
Filename box.  The current directory can be changed by editing the directory name in the 
Directory box.  A filter, following the normal DOS conventions, can be typed into the Filename 
box to reduce the numbers of files listed.  Example "TH*7" would only list labels starting with 
"TH" and ending with "7". 

 
4.1.3 Save Label 
 

The Save Label command lets you save to disk the current label format that is being worked on 
in the editor. The shortcut key for this command is F4 
 
If passwords are enabled in the Option menu, the Save command will ask you to enter a 
password which will be use to protect this particular label format, and can be different to the 
passwords defined in the password function in the configuration menu. 
 
The programme will automatically request you to save the current label format prior to exiting the 
editor, printing or downloading the label. 
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4.1.4 Save Label As 
 

The Save Label As function allows you to save the current label format with a different name, 
whilst maintaining the original label format file.  This is useful when you wish to create a new label 
which is similar to an existing label format. 
 
The Save Label As dialog shows the standard file selector list which allows you to either type the 
name of a new label format, or to save the file with an existing filename which would overwrite 
any existing data in that file. 
 
The directory, descriptor and files listed may be changed, in the manner described for the Load 
Label operation. 
 

4.1.5 Rename File  
 

This function allows you to take any existing label format and to save it with a different filename.  
This command will not create another copy of the file, but will changes the filename of the label, 
similar to the DOS command "REN". 
 
The Rename dialog lets you select an existing file from the scroll window, or to type the name of 
the file into the File Name box.  The name of the new file is typed into the Rename To box. 
 
The directory, descriptor and files listed may be changed in the manner described for the Load 
Label operation. 
 

4.1.6 Delete File 
 

The Delete file command lets you delete an existing label format file. Care should be taken when 
using this function as once a file has been deleted it is not possible to undelete the file. 
 
The Delete dialog shows the standard file selector list which enables you to select an existing file 
and delete it by responding OK at the bottom of the dialog. 
 

4.1.7 Print Label 
  
 The Print Label command runs the GLWW Print with the current label format as the first label for 

printing. The form of GLWW Print is determined by the Quick Print option in the Options Menu. 
If you have not saved your current label format before you exit, you will be warned and given a 
last opportunity to save it. 

 
 For details on using the GLWW Print Utility, see section 7. 
 
4.1.8 Shell to DOS 
 
 Shell to DOS is a duplication of the Shell to DOS command on the GLWW Menu. The GLWW 

Editor leaves little room for other applications so you may not be able to run many application 
from this shell. 
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 For details on using Shell to DOS, see section 9.0. 
 
 
4.1.9 Exit 
 
 This will exit the editor and will take you back to the GLWW Menu. If you have not saved your 

current label format before you exit, you will be warned and given a last opportunity to save it. 
  
4.2 Edit Menu 
 

The Edit menu provides an alternative way of editing the fields in the label format, which is often 
useful when you need to edit, list or delete the contents of the fields in the label format, but not to 
change the positional information of the fields, which is best done in the WYSIWYG screen. It 
also enables you to change the details entered when the label was created and the printer 
defaults. 

 

 
Fig 5 Edit Menu 

 
4.2.1 Edit Field 
 

The Edit Field command allows any of the fields in the current label format to be edited or 
viewed in the WYSIWYG screen.  The shortcut key for this function is F8. 
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The Dialog box for this function shows a list of all of the fields displayed in field number order.  
Each field has the type of field shown and the contents of the field.  A typical example of the Edit 
Field dialog box is shown in Fig 7 below :- 
 

 
Fig 6 Edit Field Menu 

 
To select a field, highlight it using either the mouse or the cursor keys.  Choosing the Edit function 
will bring up the standard dialog parameter box for the type of field selected.  Any of the 
parameters may be changed using this function, and when completed will return you to the Edit 
Field screen.  To confirm that changes made are correct the View function displays the standard 
WYSIWYG screen. 
 

4.2.2 Delete Field 
  
 The Delete Fields dialog box is very similar to the Edit fields dialog box. The View and Edit 

buttons are replaced by a Delete button.  To delete a field, select a field from the list, click on the 
delete and wait for the confirmation dialog box. To delete the field, select Delete from this Dialog 
box. 

 
 It is normally easier to delete a field by clicking on the field with the right button on the layout 

screen and selecting the delete button from the dialog box but this process is an alternative 
method which avoids need to use the graphics screen. 

 
4.2.3 List Fields  
 
 The List Fields dialog box contains a list of the fields in a label format with each fields' type, X 

and Y co-ordinates and an abbreviated form of their contents. 
 
4.2.4 Edit Label Size 
 
 This function displays the dialog box used for the Create Label function. The label size, stationery 

type, X and Y offset, cutter position and double image printing can be  changed. 
 
 For more details about this dialog box, see Create New Label (section 4.1.1). 
 
4.2.5 Edit Stationery Type 
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 Click on the Edit menu heading with the mouse and select Edit Stationery Type, which will 
display the Stationary Type dialog box. 

 

 
Fig 7  Stationary Type 

 
 The Stationary Type dialog box tells GLWW the type of stationery you intend to use. The 

Stationery Type field contains a free-form description of the stationery for reference. If you are 
using stationery with multiple labels across the web, click on the Labels Across Web text box 
and enter the number. Then click on Horizontal Label Pitch and enter the offset from the start of 
one label to the start of the next. 

 
 For continuous stationery, you must enter the height of the label to be ejected by the printer. If 

the cutter is fitted and the option selected in the Printer dialog box in GLWW Configure, another 
section will be displayed where the cutter can be disabled, activated at the end of each label or 
the end of each batch of labels by selecting the appropriate option. 

 
 For Phoenix Printer/applicators, you also can define whether the label is for a right or left hand 

constructed machine.  (ALFA Printers are normally left hand.) 
 
4.2.6 Change Printer Setup 
 
 This function displays a dialog box which allows the print density, print speed and paper type to 

be set independently of the default printer settings. The dialog box is similar to the Printer 
Selection dialog box in the Configuration Utility. You can also select the default printer to be used 
at print time. 

 For more details about this dialog box, see Printer Section, 6.6.  
 
 
4.3 Options Menu 
  
 GLWW, and in particular, the GLWW Editor contain a number of aspects that can be 

configured to the user's taste. The items on the Options Menu do not change the final label format 
but make the GLWW environment and the GLWW Editor easier to use. 

 
 The Options Menu contains a number of menu items that reverse their meaning when selected. 

For example, Hide Logos toggles to Show Logos. The current state is therefore the reverse of 
that shown on the menu. Each of the items on the menu gets a fuller explanation below. 
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Fig 8 Options Menu 

 
 Overwrite/Backup Existing Files - When a label that already exists is saved, the previous copy 

would normally be overwritten. If a mistake had been made in 
changing the label, the original version would have been lost. 
GLWW will either backup the original label (to filename.bak, 
where filename is the label format name) or will warn you that 
you are going to overwrite the file and ask you to confirm this is 
what you want to do. 

 
Request/Do not Request Descriptors - GLWW allows the user to add some freeform 

information about a label format or a field on the label. This 
information is requested when the label format is created or 
edited, if this option is set to request it. Although the information 
is often of use, the regular requests slow down the creation 
process. 

 
Enable/Disable File Password Requests -GLWW supports file passwords which if set are 

requested before a label format is loaded. If this option is set to 
Enabled, a dialog password is display every time a label is saved 
requesting the password needed for reloading the label. 

  
Enable/Disable Quick Print - Quick Printing mode is a method of printing a label format 

without using print queues. It is only available from GLWW 
Editor and is used when this option is set. 

 
Hide/Show Logos as Graphic Images - A label format containing many fields, may display slowly 

on older computers, logos taking longer to display than other 
fields. They can be replaced by a rectangle with the logo's name 
in the centre by selecting this menu item. 

 
Hide/Show Outlines -  When this option is set to Show Outlines, a rectangle surrounds 

each fields display in the Label Editor for clarity. 
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Show/Hide Grid - A visible grid can make lining up fields on a label format easier 
but a fine grid can take a little time to display on a slow 
computer. 

 
Enable/Disable Snap to Grid - When this option is enabled any field that is moved or created on 

a label is forced to line up with the grid. 
 

4.3.1 Select Grid Size  
 
 A background grid can be selected to aid field positioning. To select the grid spacing required 

click on the selection. Time is taken to draw the grid when the display is refreshed so it is 
recommended not to use a smaller grid than necessary. Confirm the selection by clicking OK, or 
Cancel by clicking on Cancel. 

  
 The grid can be visible or hidden by selecting Show Grid or Hide Grid from the Options menu. 
 
4.3.2  Select Measurement Units 
 
 The default measurement unit used by the label editor to define the label size can be specified.  

The options available for you to chose are Dots, Millimetres or inches. When you have selected 
the unit required click on OK to accept the changes or Cancel to exit without saving. 

 
4.3.3 Select Mouse Speed 
 
 The mouse speed (amount of cursor movement to mouse movement) can be varied over 

approximately a 10:1 range. Not all mice support the double speed option so you may need to 
experiment. When you have selected the mouse parameters click on OK to accept the changes 
or Cancel to exit without saving. 

 
4.3.4 Directory Sort 
 
 You can choose that the directory listing shown when you load, save, rename or delete a file 

should be sorted alphabetically (in ascending or descending order) by selecting one of the options 
in the directory sort box. 

 
 If you have more than 200-300 files in your directories, sorting the files will be quite slow. You 

may find it helpful to sort your labels into categories and store each category in a separate 
subdirectory. 

 
 When you have selected the required sort click on OK to accept the changes or Cancel to exit 

without saving. 
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5 LABEL EDITOR 
 

The label editor takes you into a screen with a row of pull-down menus across the top to enable 
all of the functions to be selected.  To design a new label  select Create New Label (Alt F C) or 
press F2.   The label format parameters screen should be completed to define the label size, file 
name and paper position.  After accepting the parameters you are taken into the layout screen 
which allows you to design the label with full WYSIWYG display.   
 

 The icons at the bottom of the screen allow you to select the particular design tool required 
according to the particular field that you wish to place on the label format. The field function is 
selected by clicking on the particular icon with the left mouse button, which causes the icon to be 
highlighted. To enter data for a particular field, position the cursor at the top left-hand corner of 
field and press the right hand mouse button. The relevant parameter screen appears to enable the 
data to be entered. When the parameters have been accepted, by clicking on OK, the field will 
be displayed on the layout screen. The field may then be re-positioned by clicking and holding 
down the left mouse button and dragging the field to the new position.  Having selected a 
particular field, pressing the right mouse button will take you back to the field parameters screen. 

 
 Boxes, lines and graphics files can be resized by holding down a shift button, clicking on the 

image with the left mouse button and dragging the outline to the correct size. 
 

Function Use 
  
Text - Fixed Alphanumeric fixed text field 

Text - Variable Alphanumeric text field which  

allows variable data entry at print 
time 

Barcode - Fixed Fixed barcode data field 

Barcode - Variable Barcode field that allows data to 
be entered at print time 

Date Date field that picks up current 
date at print time 

Time Time field that picks up current 
time when label is printed 

Line/Box Create line or box fields 

Picture Place PCX format clip art 

Text File Place ASCII text file into label 

Copy Field Duplicates the last used field and 
displaces the copy down and 
right. The last used field is the last 
field moved, changed or created 
on the graphics screen since the 
label format was loaded/created. 

Centre Horizontally Centres the last used field 
horizontally on the label 
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Centre Vertically Centres the last used field 
vertically on the label 

View Window (Larger 
labels only) 

Choose the area of the label to 
view on screen by moving mouse 
and then click left mouse button. 

Menu Go to Label Editor main menu 

Help Select help text 

Template/Printed Toggle between printed data and 
template fields that enable defined 
areas to be "mapped" onto label 
format. 

 
On a colour monitor the colour will denote the type of field that has been defined according to the 
following table :- 
   

Colour Field Type 
  

Black Fixed  

Green Variable 

Red Template 

 



GENERAL CODE           GLWW Label Design Software - User's Guide Page Q 

5.1 Fixed Text Parameter Screen 
  
 The fixed text parameter screen is shown in Fig 10 below. 
 

 
Fig 10  Fixed Text Dialog 

  
To add/change the contents of the text field click on the Field Contents Box and type in the 
required data string.  The characters are always left justified in the field. 
 
The font size for the text can be changed by clicking on the Change Font box.  The current font 
size will be shown in the box.  If you choose to change the font a dialogue box is displayed which 
enables you to change the selected font and character size. 
 
The orientation of the text on the label may be changed by changing the required selection from a 
choice of 0°, 90, 180° or 270°.  The default orientation is 0°.  The X-Y co-ordinates for the field 
may be specified by typing the required values into the X or Y ORIGIN boxes. 
 
When all of the parameters have been entered click on OK to create the new field.  If you want 
to cancel the new field click on Delete. 
 

5.2 Variable Text Parameter Entry 
 

The variable text function allows you to define text fields within the label, and to enter the actual 
text at the time of printing, either directly from the PC, or by means of the DT32 Data Terminal.  
You can define the variable field text as incrementing, or decrementing with the initial value 
entered at print time. 
 
For more details of the various types of variable field text, see section 5.4. 
 
To select the maximum number of user entered characters in the field enter the required value in 
the Field Length box.   
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5.3 Fixed Barcode Parameter Entry Dialog 
 
 The fixed barcode entry dialog allows you to enter the data for fields that will have a fixed 

barcode. The format for the dialog screen is shown below :- 
 

 
Fig 11  Fixed Barcode Parameter Entry Screen 

 
 Select the required barcode symbology from the list on the left hand side of the dialog box.  

Some of the symbologies are available with formats that will print both with and without check 
digit calculations.  The selection of the barcode will determine the default number of characters in 
the barcode,  which dependent upon the symbology chosen may be changed by entering the 
required length in the field length box.  A value for the barcode must be entered, or the default 
string will be used. 

 
 The height of the barcode can be changed by clicking on the height box and entering the required 

value.  The orientation of the barcode can be specified by clicking on the appropriate button. 
 
 Dependent upon the symbology chosen the default barcode parameters (defined in the 

Configuration Utility) may be changed within the dialog box.  The parameters that may be 
changed are the narrow and wide module widths, and the barcode magnification. 

 
 Some barcode symbologies only include a restricted range of characters. If an invalid character is 

used, an error message will be displayed. EAN-128 allows the FUNC1 character to be included 
in the code by pressing Ctrl-F (typing "F" while holding down the Control key). The character is 
displayed on the screen as a right pointing arrow ">" (on some computers the character may be a 
solid arrow). 

 
 When you have entered all of the parameters click on OK to accept the changes or Cancel to 

exit without updating the changes or creating the field. 
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5.4 Variable Barcode Parameter Entry Dialog 
 
 The variable barcode dialog is similar to the fixed barcode dialog, but with the addition of a 

number of extra options that allow you to specify the format for the variable data as shown below 
:- 

 

 
Fig 12 Variable Barcode Parameter Entry Dialog 

 
 You can now specify the prompt text for the variable entry that will appear either on the PC 

screen, or the DT32 data terminal at print time. 
 
 The way in which the prompt is handled by the printer is selected by clicking on the Prompt box, 

which then displays an option dialog which allows you to choose from the following options :- 
 

Prompt Once - At print time the variable data is requested once only and is then 
repeated on each label that is printed as part of that batch.  This 
is useful for printing batch codes, where 100 labels may be 
printed for a batch of goods that will all have the same batch 
reference number. 

 
Prompt Each Label -  At print time of a batch of labels, GLWW Print will stop 

between labels for entry of the variable text required for the next 
label.  This is useful when each label will have one (or more) 
fields that change (e.g.  part number, serial number etc.) 

 
Prompt & Increment - At print time, you can enter an initial value for the first label to be 

printed.  Each subsequent label will have a value that will be 
incremented by one from the previous label 

 
Prompt & Decrement - This is similar to above, but will decrement by one from the initial 

value entered. 
 
Always Increment - At print time the printer will increment this field for each label 

printed by one.  The initial value is determined by the value 
printed on the last label of this type - even after the program is 
exited and the computer is switched off.  This function is useful 
for serial number labelling. 
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Always Decrement -  This is similar to above, but will decrement by one from the value 
from the last label printed. 

 
Database Input - This feature allows you to specify a field within a record of a 

database that will be used for the contents of the field. GLWW 
supports text delimited and dBase format databases. Once you 
have chosen which format, another dialog box shown below that 
lets you specify the format for the database field. This option is 
explained is further detail below. 

 
Linked - You can link one variable field to another so that information only 

has to be calculated or requested once. When the source field is 
deleted, the destination field will also be deleted. 

 
Auto Date/Time  - The date/time variable text field allows you to embed a date or 

time which will automatically be updated by either the system 
clock in the PC, or the real time clock maintained within the 
DT32.  The field is shown on the screen as the time when the 
field was last changed. It is updated at print time and when the 
field's details are changed. This option is explained is further 
detail below. 

 
5.4.1 Text Database Field Parameter Entry Dialog 
 

 
Fig 13 Database Field Parameter Entry Dialog 

 
 To select a text database or to change to a different one, click on Select Database and choose 

the database file from the standard directory listing box. 
 
 Database information can be imported provided it is prepared in a correct and consistent format. 

The database file must be a character separated ASCII text file and have the suffix .TXT. One of 
the records (usually the first) is selected as representative of the maximum field width for the 
database. This is used to determine the number of characters to clear in each field of subsequent 
labels.  

 
 To select the field and pattern record numbers click on the respective text and enter the number 

in the text box. The Pattern Record is used to determine the amount of space to leave on the 
label for this field. It should represent the largest field that might be encountered. To select the 
first field to the printed, click on First Print Record and enter the record number. You will be 
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asked to confirm this number when you print the label. This number is increased by one every 
time a label is printed. 

  
 The field separator can be a Tab character (ASCII 9) or any ASCII character. To change the 

field separator, click on Tab or click on the Field Separator box and enter the single separator 
character.  

 
 The record separator can be a carriage return character (ASCII 13, 10 or both) or any ASCII 

character. To change the record separator, click on CR (short for Carriage Return) or click on 
the Record Separator box and enter the single separator character.  

 
 When you have entered all of the parameters click on OK to accept the changes or Cancel to 

exit without updating the changes or creating the field. 
 
5.4.2 dBase Database Field Parameter Entry Dialog 
 

 
Fig 14 dBase Field Parameter Entry Dialog 

 
 To select a dBase database or to change to a different one, click on Select Database and choose 

the database file from the standard directory listing box. 
 
 GLWW supports both dBase III and dBase IV fields. Only integer decimal and date fields can 

be imported into numeric barcodes. 
 
 To select a field, either select Database Field No. and enter the field number or click on Select 

Field and select the field from the list. The select a pattern record number click on the text box 
and enter the number. The Pattern Record is used to determine the amount of space to leave on 
the label for this field. It should represent the largest field that might be encountered. You will be 
asked to enter the number of the first printed field when you print the label. This number is 
increased by one every time a label is printed. 

  
 When you have entered all of the parameters click on OK to accept the changes or Cancel to 

exit without updating the changes or creating the field. 
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5.4.3 Auto Date/Time Dialog 
 

 
Fig 15 Auto Date/Time Parameter Entry Dialog 

 
 You can choose between date and time format and for the date specify UK, European or US 

and Japanese format.  It is also possible to enter an offset for the date in number of days from the 
current date.  This can be useful to automatically enter a "Sell by" or "Use by" date. 

 
 The barcode must be large enough to contain the numeric representation of the time or date or an 

error will be produced. 
 
 You can specify whether the date or time printed on the label will be changed from one label to 

the next in a batch of labels. By selecting Fixed Date/Time, you can speed up printing by keeping 
the date or time constant. 

 
5.5 Date Entry Dialog 
 
 The date entry field allows you to print a date which will automatically be updated by the system 

clock in the PC. The field is shown on the screen as a series of 0's which represent the particular 
format selected.  The date entry dialog is shown below :- 

 

   
Fig 16 Date Entry Dialog 

 
 You can specify the format for the date displayed between UK, European, US and Japanese.  

Like other text fields you can also specify the font used for the date field and the orientation for 
the field.  It is also possible to enter an offset for the date in number of days from the current 
date.  This can be useful to automatically enter a "Sell by" or "Use by" date. 
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 You can also choose whether the date printed on the label will be changed from one label to the 
next in a batch of labels. By selecting Fixed Date, you can speed up printing by keeping the date 
or time constant. 

 
5.6 Time Entry Dialog 
 
 The time entry dialog lets you specify the format for the time in a similar way to the date.  The 

dialog let you enter the font to be used as well as the orientation of the text. 
 

 
Fig 17 Time Entry Dialog 

 
 You can specify whether a 12 or 24-hour clock is used and the separator between the three 

elements of the time. You can also choose whether the date printed on the label will be changed 
from one label to the next in a batch of labels. By selecting Fixed Date, you can speed up printing 
by keeping the date or time constant. 

 
5.7 Box/Line Entry Dialog 
 
 GLWW can include lines and boxes in label formats. Once they have been added to the label 

format, they can be changed by click on the field with the right mouse button. To change the field 
from a box to line, selected Vertical Line or Horizontal Line. To change the dimensions, click on 
the appropriate text entry box and type in the correct size. Boxes and lines can be black or 25% 
grey. To change the colour, click on the appropriate setting. 

 
 Once the box or line has been created, its dimension can be changed on the graphics screen by 

holding down a shift key, clicking with the left mouse button on the field and dragging it to the 
correct size. 

 
5.8 PCX Logo File Entry Dialog 
 
 GLWW can import black and white and 256-colour greyscale PCX files directly into a label 

layout, and will then convert these automatically to a binary file when they are transferred to the 
printer or DT32. Graphics bitmaps can be rotated like any other field and can be scaled either by 
entering new sizes into the dialog box or by clicking with the left mouse button on the logo while 
holding down the shift key and dragging the box out to a new size. 

 
 GLWW will adjust itself to 256-colour greyscale images by dithering the image to black and 

white. The dither occurs after the scaling so that the quality of the image is preserved. You can 
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choose between three dithers for screen display. Bayer's is much faster than the other two but 
displays quickly. Burkes' dithers are slower but of higher quality. The darker Burkes dither 
represents the image with the correct proportion of black and white to represent the grey. The 
lighter dither is display exactly as it will be printed. The greys in this dither have been transformed 
for optimum printing. 

 
 The program asks you whether the file image will be taken from an existing logo in memory or 

from a disk file.  GLWW will automatically store any logos already placed on the current label so 
that more than one copy may be used.  If you select File the program will display a list of  files 
having a PCX extension which are in the directory from which the program was run.  You can 
change the default directory by clicking on the directory box and typing a new directory. You can 
reduce the size of the list of logos by typing a filter into Filename box. 

 
 Greyscale images reply on the Print Density in the Change Printer Setup dialog box being set 

correctly. Paper and ribbons supplied by GENERAL CODE should produce best results with 
the print density set at 100% but other papers or ribbons may produce better results with higher 
or lower settings. The best way is to experiment. A test image (GREYSCAL.PCX) is supplied 
on the distribution disk to help determine the ideal setting. 

 
 Once you have selected the file required you can only change the X and Y co-ordinates and size 

of the image as shown in the figure below :- 
 

 
Fig 18 Logo Dialog 

 
5.9 Text File Entry Dialog 
   
 The text file field allows you to select an ASCII format file which can be placed onto the label.  

This file is then treated as a single field, and can only be re-positioned as a single field. 
   
 The initial Text File Dialog lets you select a file from a list in the default directory which has a 

.TXT extension. The default directory can be changed by clicking on the directory box and 
typing in the new directory name. Once you have selected the required file another dialog box is 
displayed which allows you to change the font size and orientation of the text field. The extra line 
spacing can be entered as a percentage of the vertical font size. 
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5.10 Font Selector 
 
 Fixed, Variable and File Text, Time and Date Fields all allow the select the font typeface, size 

and effects from the Font Selector. To change the font being used by a field, select Choose Font 
from the main dialog box. The font selector is shown in fig 19. 

 

  
Fig 19  The Font Selector 

 
 To choose the typeface, click on its name in the Font section. To change the size, either click on 

one of the listed sizes or click on Vert. Size/Hor. Size. To change the font size to one not already 
listed, click on Vert. Size/Hor. Size and enter the Vertical and Horizontal point size required into 
the black text boxes. The two sizes are set independently and can be between 3 and 999 points 
(assuming the label is big enough). 

 
 The fonts shown in Fig 20 are included as standard with GLWW and new ALFA printers. The 

fonts have been enlarged for this manual. The quality will be higher in normal use. 
 

 
Fig 20  GLWW Fonts 

 
 Kerning is the process of moving characters closer together to improve their appearance. For 

example, if the letters "AV" were spaced normally, there would be more white space between 
them than the letters "ML". Kerning would move the letters "AV" closer (often allowing the left of 
the "V" to start above the right of the "A"). Kerning can bring characters a little closer or much 
closer. GLWW represents kerning on a scale on 0 to 3 where 0 is no kerning and 3 is tight 
kerning. To change the kerning select one of the numbers 0 to 3. 

 AV  ML  AV 
     Not kerned          Kerned 
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 To italicise the font, select Italics or to print White text on a black box, select Inverse. When 
characters need to be read quickly or by a machine, extra spacing between each letter can often 
improve clarity. Spacing can be increased by multiple of 10% of the horizontal point-size. To 
change the spacing, select on the Extra Characters Spacing box and enter a number between 0 
and 9 (0 to 90% more space). 
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6 CONFIGURATION UTILITY 
 
 The configuration pull-down menu allows you to define barcode formats, output port, 

communications protocol, measurement parameters, nationality, printer format, password 
protection and paths.  The menu is selected by clicking on the Configure button on the menu bar, 
or using the hot key (Alt-C). 

 

 
Fig 21  Configure Menu 

 
6.1 Barcode Defaults 
 
 The magnification and module width of the different symbologies are preset, which is determined 

by the dot resolution of the printer. The normal default for printers is a magnification factor of 2 
which will give a module size of 0.33 mm on 6 dot/mm printers and 0.25 mm on 8 dot/mm 
printers. 

 

 
Fig 22 Barcode Configuration Dialog 

  
 The module width for EAN barcodes cannot be changed as these are defined by the symbology. 

To change other parameters click on the particular box and enter the new value. When all of the 
required changes have been made click on the OK button. If you wish to exit without updating 
the values click on the cancel button. The defaults widths are shown in fig 22. 
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6.2 Communications Settings 
 
 Changes to the set-up for the communications apply to all of the serial ports available on your 

machine. To change the value click on the required option box. When all of the changes are 
complete, click on OK to accept the changes or cancel to exit without updating the changes. The 
setting must match exactly those in the printer or DT32 terminal. 

 
6.3 Printer Selection 
 
 Multiple printers of different models can be used with GLWW simultaneously. Only one printer 

can be attributed to each communications port on a computer. To change the printer attached to 
a port, click on the line containing the port's name and select the Printer button. The Configure 
Printer dialog box will be displayed.  

 
 GLWW defines different parameters dependent upon the printer that is selected (resolution, print 

width, speed, head temperature), and so you must select the printer that you will be using with 
the software.  

 
 To select the printer model being used click on the printer model box and press the Enter key.  A 

list of available printer drivers will pop-up.  Please refer to the table below for cross-reference 
name of printers: 

      Commercial name:        Factory name: printhead width      resolution 
   ALFA 2050   ALFA 1050  LP568        56 mm        8 dots/mm 
   ALFA 2100   ALFA 1100  LP1048     104 mm        8 dots/mm 
   ALFA 2050/6  ALFA 1050/6  LP526        52 mm        6 dots/mm 
   ALFA 2100/6   ALFA 1100/6  LP1056     105 mm        6 dots/mm 
 

 
Fig 23  Printer Configuration Dialog 

  
 To select a particular driver click on the printer required and press OK to accept, or Cancel to 

exit without saving the changes. 
 



GENERAL CODE           GLWW Label Design Software - User's Guide Page CC 

 The default print speed or print density can be set by clicking on Printer Speed or Printer Density 
and entering an appropriate value. The valid speed range is 40-139 mm/s and print density is 
50% to 200% of the factory default setting. 

 
 To enable the External Rewinder or Label Present Sensor (mounted on the front of the printer 

above the label) click on their options. If a cutter is fitted, select Cutter Fitted and a range of 
extra options will be displayed in the Stationery Type allowing you to control its use. 

 
 Once the changes have been made, select OK to return to the list of printers. 
 
6.4 Passwords 
 
 You can configure the program to set access to the system which is controlled by Passwords.  

To set a Password click on the text entry box for the program and type in the Password 
required.  When all of the changes are complete click on OK to accept the changes, or Cancel to 
exit without updating the changes. If any of the text entry boxes are left blank then no password 
will be requested for that program. 

 
6.5 Paths 
 
 The DOS system of paths allows files to be kept in groups. GLWW encourages the use of 

directories by allowing different default directories for each file type. The default directories are 
those listed when Load Label, Save Label, Select Database, etc. are chosen. 

 

 
Fig 24 Paths Dialog 

 
 To set a Path, click on the text entry box for that type of file and type in the path required. Paths 

should be entered in full, including the drive letter. 
 
 GLWW keeps a reference including a full path of imported files in every label. so if a file used in 

a label is moved, GLWW will not be able to find it when the label format is next used. If you 
specify a set of Working Directories, GLWW will look for the file in these directories if it is not 
found in its initial path. 

 
6.6 Exit Configuration 
 
 To exit the configuration menu and return to the Main Menu select exit. 
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7 PRINT UTILITY 
 
 The Print Utility is a sub-program of the GLWW Editor but can also be used as a separate 

standalone utility. The Print Utility prints label formats that have already been defined using the 
label editor.  The number of labels to be printed and any variable information which has been 
defined will be entered at this stage. 

 
 To print a label format, either select Print from the File Menu of the GLWW Editor or select 

Print Utility from the main GLWW Menu. If you select Print from the GLWW Editor with the 
Quick Print option enabled, a simplified interface will be used - see section 7.5. 

 
7.1 Print Queue 
 
 When the Quick Print option is not being used, GLWW Print uses the print queue. List of 

formats can be set up and variable field data entered independent of the printer speed. 
 

 
Fig 25 Print Queue 

 
 Printing takes place in two stages. During the first, known as preparing, variable field data is 

collected from the user, or from a database, or by incrementing or decrementing previous data. 
This stage is often very quick. If a label contains no prompted or database data, thousands of 
labels may be prepared in a second. 

 
 Once the preparation process has been started, the second process starts. Known as printing, 

this is the stage where the label formats are passed to the printer for printing. This process runs in 
the background while GLWW Print is running. 

 
 Once preparation of all the formats is complete, more formats can be added and the menus 

become operative again. If you leave GLWW Print, printing may pause until you start it again. 
Warning: If you switch off the printer before restarting GLWW Print, printing may not restart 
properly. 

 
 GLWW Print supports up to 5 printers of the same type simultaneously (on ports COM1, 

COM2, LPT1, LPT2, LPT3). 
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 Once printing has started, it can be suspended by selecting Pause Output to Printer from the 
Printer Menu. A few labels may print before the printer buffer is cleared. If a label format does 
not contains any prompted or database fields, all the label formats may have already been sent to 
the printer. The printer can still be stopped by selecting Stop Printer from the Printer menu. This 
command only works with labels with fixed fields. 

 
7.2 Label Menu 
  
7.2.1 Add Label Format 
 
 To add a label format to the print queue, select Add Label Format from the Label Menu or press 

F2. The normal directory listing box will be displayed. Select the name of the label format and 
click on OK. The Add Format dialog box will be displayed. 

 

 
Fig 26  Add Format 

  
 To change the number of copies, click on the No. of Copies text box and enter the number 

required. To identity who added a label format to the queue, the user can enter his or her into the 
User's Initials text box. The Initials then become the default ones. This information is displayed in 
the queue list and in the Print Report File. To change to a printer on a different port select the 
name of the port. If File is selected, the filename will be requested when the preparing stage 
starts. You can only change to ports that are listed with printers in the Printers section of GLWW 
Configure.  

 
 To confirm the selection, click on OK. If the Preview Label option has been selected, a preview 

of the label will be display. Click on Continue or Cancel to accept or reject this format. 
 
7.2.2 Remove Label Format 
 
 If a label format has been added to the queue in error, you can remove it by clicking on the errant 

label format in the last and selecting Remove Label Format from the Label menu or pressing F3. 
 
 This option can also be used to remove a format during the printing stage if the Output to the 

Printer has been paused. 
 
7.2.3 Copies 
 
 To change the number of copies needed of a label format already in the print queue but not yet 

prepared, select Copies, click on the No. of Copies text box and enter the correct number. This 
command can also be used to change the initials or the port to be used for printing. 
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 If this command is used after a label format has been printed (when the Status is marked as 
Done), it can be used to print more copies of the label format. Enter the number of extras copies 
in the text box and select OK. The Status will change from Done to Waiting. 

 
7.2.4 Shell to DOS 
 
 If you have enough memory, you can run a DOS shell to enter DOS commands temporarily 

before returning to GLWW. While you are in DOS, no more label formats will be sent to the 
printer, but the printers will continue to process any formats they have received. 

 
7.2.5 Exit 
 
 Leave GLWW Print and returns to the GLWW Editor or the GLWW Menu. If GLWW Print is 

still printing, the output to the printer will be suspended. The printing will continue when you 
restart GLWW if the printer has not been switched off. 

 
7.3 Printer Menu 
 
7.3.1 Start/Stop Preparation 
 
 When you have added at least one label format to the list, selecting Start Preparing/Stop 

Preparing from the Printer menu (or press F10) will start the preparation of the listed label 
format. Any prompted fields will be requested and any database information will be collected. 
Once preparation is completed (normally after just a few seconds), the menus become operative 
again. 

 
 Stop Preparing can be used to abort the label format preparation but will not stop the output to 

the printer of label formats that have already been prepared. 
 
7.3.2 Pause/Restart Output to Printer 
 
 Once label formats have been prepared, they are sent, in the background, to the printer. To stop 

the flow of information to all the printers, select Pause Output to Printer from the Printer Menu 
(or press F9). To restart the flow, select Restart Output to Printer from the Printer Menu (or 
press F10 again). 

 
 If a label format does not contains prompted or database fields, the label format will only be sent 

to the printer once and therefore Pause Output to Printer will have no effect once the information 
for the first label has been sent. 

 
7.3.3 Stop Printer 
 
 If a label contains only fixed fields, an instruction will be sent to the printer to print the same label 

as many times as instructed. To stop the printer, select Stop Printer from the Printer menu, select 
the port of the printer to be stopped and click on OK. 

 



GENERAL CODE           GLWW Label Design Software - User's Guide Page GG 

 
Fig 27  Stop Printer 

  
 The copies counter will not be reduced by the number of labels not printed so its value will 

become meaningless. 
 
 If more label formats have been sent (or are being sent to the printer), then this command will be 

ignored. 
 
7.4 Options Menu 
 
7.4.1 Pause Between Formats 
 
 When printing several batches of label formats, it is often useful to pause between batches to 

change labels in the printer or to move label from the rewinder. By selecting this option from the 
Options menu, GLWW will automatically pause at the end of each batch of labels as if Pause 
Output to Printer had been selected from the Printer menu. To restart output, select Reset Output 
to Printer from the Printer menu or press F9. 

 
7.4.2 Preview Labels 
 
 It is often useful to be able to view a label format in order to verify it before it is added to the 

queue. If this option is selected, the label will be displayed on the screen after it has been selected 
from the directory listing box. Above the label will be two buttons - Continue and Cancel. 
Selecting Continue will add the label format to the list, but selecting Cancel will abandon it. 

 
7.4.3 Start Printing After Add 
 
 If you regularly only print one label format at a time, selecting this option can simplify the printing 

process. With this option selected, preparation of label formats will start immediately after a label 
format has been added to the queue. 

 
7.4.4 Reset Counter 
 
 The counter is on the right of the menu bar. When printing is complete, the number of copies sent 

to the printer, are added to the counter. It can be used to determine how many labels have been 
printed from a reel and used as a guide to the number left. 

 
 If the Stop Printer command is used, the number of labels stopped is not subtracted so the 

counter reading is then no longer valid. 
 
7.5 Quick Print Mode 
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 If Quick Print is enabled in the GLWW Editor and Print is selected from the File menu of the 
GLWW Editor, GLWW Print uses a quicker non-queuing mode. The same Add Format dialog 
box is displayed but the label format details are displayed in a smaller box: 

 

 
Fig 28 Quick Print Progress Window 

 
 When the label format has been printed, GLWW Print returns immediately to the GLWW Editor. 

The counter and the report file are both updated although the counter is not displayed. 
  
 
7.6 Printing Trouble Shooting 
 

Symptom Check 

No labels printed Printer attached and switched on 
Paper (and wax ribbon on thermal printers) present 
Cable connected to correct port 
Baud rate, parity etc. in GLWW Configuration Utility 
match those on the printer DIP switches. NB. GLWW 
requires that all printers use the same communication 
parameters 

Poor print quality Print head is not dirty 
Correct heat setting (See section 6.6) 
Correct speed setting (See section 6.6) 
Paper is good quality and has not been mistreated. 

Label format on screen does 
not match printed label 

The printer type listed in the Printers section off GLWW 
Configure matches the printer in use. 

Time/Date print incorrectly  Your PC's clock has right time 
Date offset is correct (See section 5.5) 
Correct local time/date format chosen  

Some fields don't print Correct printer driver is being used 
All files used when label was created are still present 

Some country-specific 
characters don't print 

DOS version 5.0 or later present 
Code pages are set up correctly in your 
AUTOEXEC.BAT and CONFIG.SYS files 
Characters are ALFA Printers' character set. See 
appendix A. 

Database fields print 
corrupted or do not print 

Check the pattern record is the largest record 
Check database has sufficient records 
Database file is still present on disk 
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8 DOWNLOAD TO DT32 
 
 This utility is for use in conjunction with the DT32 Control Panel, which allows pre-defined label 

formats to be transferred to the DT32 for printing in stand-alone applications. 
 
 The Download Utility can download single label formats picked individually, a batch of formats 

or a mixture of both. The batch lists can be edited in a DOS text editor or from the Download 
Utility's Main Menu:- 

 

 
Fig 29 GLWW Download Utility Main Menu 

 
 Before loading the Download Utility, the DT32 Data Terminal must be active, have a memory 

card present and be connected to the PC. The download header is sent before the menu is 
displayed so if the menu is not displayed, recheck the DT32 and the connections. 

 
8.1 Download Format 
 
 This command lets you download a single label format.  Activating this option brings up the Load 

Label dialog box.  
 

The required label format can either be selected from the list of files, or by typing the file name 
into the Filename box.  The current directory can be changed by editing the directory name in the 
Directory box.  A filter, following the normal DOS conventions, can be typed into the Filename 
box to reduce the number of files listed. 

 
 When you select Ok, the label format starts downloading. The block number on GLWW should 

always match that on the DT32 and indicates the download is progressing successfully. Any 
errors are displayed in the Downloading Progress box:- 

 
Fig 30 Download Progress Box 

 
8.2 Create New Batch of Formats 
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 It is often easier to download a batch of labels onto a memory card than to remember which 
formats to use and downloading them individually. GLWW provides an environment where a 
batch list can be prepared and altered before being the label formats are downloaded. 

 
 To create a new list, select Create New Batch List from the GLWW Download menu and type 

in a name for the batch list (the name can be up to 8 characters long). GLWW Download batch 
files always have the extension ".DT". 

 
8.3 Edit Batch List 
 
 The batch list file contains the full name of all the formats in the order they will be downloaded to 

the DT32 Download Terminal. 
 

 
Fig 31 Batch File Editor 

 
 To add another label format, click on Add, select the label format required from the Directory 

Listing box and click on Ok. To remove a label format, click on the label format in the batch file 
listing box, and then click on Remove. 

 When the batch file is complete, select Done and the batch file will be saved. 
 
8.4 Download Batch of Formats 
 
 To download a batch of formats, select Download Batch of Formats from the Download Utility's 

main menu and choose the name of the required batch file form the Directory Listing displayed. 
Then select Ok. The name of each label format any downloading errors will be displayed in the 
Download Progress box during downloading. 

 
8.5 Exit 
 
 To complete the downloading process, select Exit from the Download Utility's menu. Any logos 

contained in the label formats downloaded will now be downloaded to the Download Terminal. 
If there are many logos, this may be quite slow. At 9600 baud, you must allow at least 1 second 
for every 1000 units in the block. 
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9 SHELL TO DOS 
 
 This will temporarily enable the program to be suspended and will allow you to shell out to the 

DOS prompt.  The program can be restarted by typing Exit at the DOS prompt. 
 
 The program is only suspended and is still in memory so the memory available to other programs 

is reduced. Some programs may not have enough memory to run. 
 
 This command is also available from within the GLWW Editor and the GLWW Configuration 

Utility. 
 
 
 
 
 
 
 
10 EXIT 
 
This will exit the program and take you back to the DOS prompt. 
 



GENERAL CODE           GLWW Label Design Software - User's Guide Page LL 

APPENDIX A - SUPPORTED CHARACTER SET 
 
 The GLWW set of programs support the characters shown below. They are mapped from 

National character sets onto this set. 
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APPENDIX B - CODEPAGES AND LANGUAGE SPECIFIC CHARACTERS 
 
 GLWW is used internationally for label format design and printing. It uses information provided 

by DOS to adjust to the keyboard and character code pages used on different computers. 
 
 In order for GLWW to work correctly, MS-DOS V3.3 or later is needed and CONFIG.SYS 

and AUTOEXEC.BAT must contain the necessary information. On most computers, the DOS 
Setup routine adds the appropriate commands. This section may be of interest when foreign 
characters (those characters not present in the original ASCII character set, 32-127) fail to print 
or the wrong characters are printed. 

 
 In the CONFIG.SYS, there should be the line: 
  COUNTRY = XXX,[YYY],<path>COUNTRY.SYS 
 where XXX is the country code (this is often, the international dialling code for your country) and 

YYY is the default code page for DOS to use. 
 
 The value of YYY determines the code page and range of characters available for use on the 

WYSIWYG screen. GLWW supports all common character code pages, but for any one 
country only two code pages are legal. The table below shows the recommended code page for 
many countries. 

 
 Country/Language Code page Country/Language Code page 
 English / US. 437 Sweden 850 
 Germany 850 Finland 850 
 French 850 Poland 852 
 Netherlands 850 Hungary 852 
 Belgium 850 Portugal 860 
 Spain 850 Canadian-French 863 
 Italy 850 Norway 865 
 Switzerland 850 Denmark 865 

 
Many countries can also use code page 850. GLWW supports all the characters shown in 
Appendix A. A few rarely used characters listed in these code pages are not currently available 
in GLWW. 
 
If the correct characters are not being displayed on the text screen, try adding the following lines 
to the ends of your AUTOEXEC.BAT: 
 MODE CON CODE PAGE PREPARE = ((YYY) C:\DOS\EGA.CPI) 
 MODE CON CODE PAGE SELECT = YYY 
 
The first line, loads the correct code page into the screen character buffers while the second, 
makes the correct code page the active code page. 
 
DOS allows printers to support Codepages as well as the screen devices. Printers are supported 
by adding extra lines to the CONFIG.SYS loading .CPI files or by using the MODE LPT1: 
command in the AUTOEXEC.BAT. ALFA Printers do their own code page translation and 
having these commands present, may prevent correct printing. 
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APPENDIX C - GLWW INSTALLATION NOTES 
 

System Requirements 
 
• IBM-PC or compatible 
• DOS 5.00 or higher 
• Hard disk (minimum 2MB free) 
• 640K main memory (minimum 520K free) 
• 384K Extended or Expanded memory 
• Microsoft compatible mouse 
• VGA card & monitor 
• A free serial or parallel port for the printer 
 
 
Checking the DOS version 
 
At the C: prompt, type VER ↵ 
The PC will report the DOS version number, e.g. 
MS-DOS Version 6.20 
Ensure that the version reported is 5.00 or greater. 
 
 
Checking hard disk space 
 
At the C: prompt, type DIR ↵ 
The PC will give a list of files, ending with a report of the amount of free disk space, e.g. 
  3325952 bytes free 
Ensure that the free space is at least 2,000,000 bytes. 
 
 
Checking free memory 
 
At the C: prompt, type MEM ↵ 
The PC will report the amount of memory available. The format of the report is different in DOS-5 and 
DOS-6. The important features are highlighted in the examples below. 
 
DOS-5 memory report :- 
 
    655360 bytes total conventional memory 
    655360 bytes available to MS-DOS 
    524384 largest executable program size 
 
    655360 bytes total EMS memory 
    393216 bytes free EMS memory 
 
   3145728 bytes total contiguous extended memory 
         0 bytes available contiguous extended memory 
   2457600 bytes available XMS memory 
           MS-DOS resident in High Memory Area 
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DOS-6 memory report :- 
 
Memory Type        Total  =   Used  +   Free 
----------------  -------   -------   ------- 
Conventional         640K       92K      548K 
Upper                123K      123K        0K 
Reserved             128K      128K        0K 
Extended (XMS)     3,205K    2,181K    1,024K 
----------------  -------   -------   ------- 
Total memory       4,096K    2,524K    1,572K 
 
Total under 1 MB     763K      214K      548K 
 
Total Expanded (EMS)                1,024K (1,048,576 bytes) 
Free Expanded (EMS)                 1,024K (1,048,576 bytes) 
 
Largest executable program size       548K (561,552 bytes) 
Largest free upper memory block         0K       (0 bytes) 
MS-DOS is resident in the high memory area. 
 
The important values to note are the largest executable program size, which must be 520K or greater, 
and the amount of free expanded (EMS) memory, which must be 384K or greater. If there is not enough 
memory free, then it may be possible to edit the system configuration files to give access to more 
memory. Unfortunately, there is no one solution which can be applied to every computer system, as each 
PC will be set up differently. The following guidelines are taken from the MS-DOS user's guide, and 
assume some familiarity with the workings of DOS. For further information, consult the manuals supplied 
with your PC, and your PC supplier. 
 
If you are running DOS-6, the MemMaker program can be used to optimise your computer's memory 
usage. This is probably the simplest approach and avoids having to edit the system files by hand. See the 
Microsoft manuals for details. 
 
If your PC has extended memory (referred to as XMS in the MEM command report), ensure that your 
CONFIG.SYS file starts with a line similar to the following, ensuring that the correct full pathname is 
supplied :- 
DEVICE = C:\DOS\HIMEM.SYS 
The next line should install the Extended memory manager, EMM386. This will allow programs to use 
additional memory, and also allows the XMS memory to be used as EMS memory. In DOS-5, the 
CONFIG.SYS file should contain a line similar to the following :- 
DEVICE = C:\DOS\EMM386 384 RAM AUTO 
In DOS-6 you can omit the number 384 as the whole of extended memory can be used by default. 
 
To free conventional memory, DOS should be loaded in the high memory area, so the CONFIG.SYS 
file should contain the line :- 
DOS = HIGH,UMB 
Any additional device drivers (lines starting with DEVICE = ...) should be loaded into high memory by 
substituting DEVICEHIGH = ... 
Do not install any device drivers that you do not actually need; they all take up memory. 
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In the AUTOEXEC.BAT file, TSR programs such as DOSKEY, MODE, SMARTDRV, network card 
drivers, etc. should be loaded into high memory if possible (or removed if not required), by prefixing the 
command with LOADHIGH or LH. 
 
If you have installed a RAM-disk driver (e.g. RAMDRIVE.SYS), you can save memory by reducing its 
size or removing it entirely. 
 
If you have installed SmartDrive (Microsoft's disk cache program), you can save memory by reducing 
the cache size. 
 
 
Windows Installation 
 
The Windows installation program requires Windows Version 3.1 or higher in order to run correctly. If 
your Windows version is older than this, run the DOS installation instead. 
 
 
Software Security Device (Dongle) 
 
In order to protect the GLWW package from unauthorised copying and distribution, the software will 
only operate on a machine fitted with a dongle. The dongle should be fitted to the PC parallel port 
(sometimes labelled Printer or LPT1). Any device already connected to the parallel port should then be 
connected to the dongle instead. The dongle does not interfere with the operation of the port in any way. 
If the software is run without the dongle, a warning message is displayed prompting you to replace it 
immediately. NOTE: in some cases, where a printer is connected to the dongle and the printer is not 
switched on, the dongle will not operate. Either disconnect the printer or switch it on. 
 
 
Printing Problems 
 
If the label editor runs correctly, but the program crashes when a label is printed, the most likely cause is 
an interrupt conflict within the PC. This may be caused by an add-on card such as a network interface, 
additional I/O card, etc. Either resolve the conflict by changing interrupt numbers (consult your PC or 
add-on card supplier), or connect the printer to a different port. 
 
 
Password Problems 
 
Occasionally, where there have been installation problems as described above, the GLWW configuration 
file is not updated properly, and the program prompts for passwords unexpectedly. To generate a new 
configuration file, type the following commands :- 
CD \GLWW ↵ 
DEL GLW.CFG ↵ 
GLWCFG /C ↵ 
NOTE: If you have installed the software in a directory other than C:\GLWW, substitute the directory 
name for GLWW in the first command above. 
 


